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Looking	to	try	before	you	buy?	Get	access	to	our	most	comprehensive	plan	for	14	days.	Try	It	Free	Everything	you	need	to	get	started	with	Bluebeam	Revu	for	desktop	and	Bluebeam	Cloud	for	Mac,	iPad	and	Android.	Youll	need	to	buy	a	subscription	plan	or	start	a	trial	to	access	Revu	21	and	Bluebeam	Cloud.	Bluebeams	subscription	plans	give	you
access	to	our	latest	version	Revu	21,	as	well	as	Bluebeam	Cloud,	our	new	suite	of	solutions	for	web	and	mobile.	Heres	whats	new	in	Revu	21.	You	can	purchase	a	Bluebeam	subscription	plan	in	our	web	store	to	access	Revu	21	and	Bluebeam	Cloud.	To	verify	which	version	you	have	on	your	Windows	computer,	click	Start	>	Settings	>	Apps	and	search
Revu.	Youll	need	your	Bluebeam	ID	to	access	Revu	21	and	Bluebeam	Cloud.	If	you	purchased	a	subscription,	youll	just	need	your	BBID	to	access	Revu	21	and	Bluebeam	Cloud.	For	Revu	20	or	an	earlier	version,	youll	need	a	serial	number	and	product	key	to	register	Revu.	For	help	with	finding	your	product	key,	check	out	this	article.	This	could	mean
that	you	havent	purchased	a	Bluebeam	subscription,	or	youve	logged	in	with	a	BBID	not	associated	with	your	current	subscription.	You	can	view	our	plans	here.	If	youre	a	Bluebeam	subscriber,	alerts	will	appear	in	Revu	21	when	new	updates	are	available	and	you	can	choose	to	update	at	that	time.	For	Bluebeam	Cloud,	youll	receive	ongoing	updates
automatically	on	the	web	and	the	iOS	app	may	need	to	be	updated	periodically	on	your	device.	If	youre	using	Revu	20,	alerts	will	appear	when	new	updates	are	available	and	you	can	choose	to	update	at	that	time.	You	may	be	using	a	serial	number	and	product	key	for	an	older	version.	Contact	us.	You	can	easily	access	your	drawings	and	documents
from	Revu	on	any	web	or	iOS	device	by	logging	into	Bluebeam	Cloud.Try	Bluebeam	free	for	14	days.	Bluebeam	is	available	to	download	and	trial	for	14	days.	Youll	get	access	to	our	current	version,	Revu	21,	and	our	most	comprehensive	plan,	Complete,	plus	Bluebeam	Cloud	to	collaborate	on	project	documents	and	track	punch,	RFI	and	submittal
workflows	on	the	go.	Bluebeam	develops	construction	software	solutions	that	help	architects,	engineers,	and	builders	to	communicate	better	between	the	office	and	the	field.	Any	workflows	that	would	have	traditionally	been	completed	on	paper	like	quantity	take-offs	and	design	reviews,	can	now	all	be	done	digitally	in	Bluebeam.	What	is	Bluebeam
Studio?	Bluebeam	Studio	is	a	collaborative	workspace	thats	built	into	Revu,	so,	you	can	have	all	your	project	information	there	like	your	drawings.	You	can	even	have	other	Excel	files,	and	other	formatted	software	saved	into	there.	Or	you	can	also	go	to	Studio	Sessions,	which	is	a	PDF	collaboration	space,	where	you	can	invite	other	people	to	do	live
markups	with	one	another	and	then	effectively	report	on	this.	So,	it	is	a	live	collaborative	space.	Bluebeam	Cloud	is	a	cloud-based	web	and	mobile	platform	that	enables	users	to	use	the	documents	they	have	in	Revu	on	the	go.	While	youre	onsite,	you	can	post	RFIs,	manage	documents,	and	complete	defect	inspections.	Definitely.	First,	youre	going	to
make	sure	your	drawing	sheets	are	calibrated	so	you	have	the	right	scale	involved.	From	there,	weve	got	a	whole	range	of	tools	you	can	use.	We	have	area,	polylength,	you	can	do	volume,	you	can	do	counts	and	so	forth.	But	everything	on	the	PDF	is	a	2-in-1	source	of	information,	its	in	the	markup	list,	and	that	will	add	up	on	the	fly.	As	an	extra	little
bonus,	you	can	create	a	legend	on	the	drawing	sheet	of	specific	markups	or	measurements,	and	itll	add	them	up	on	the	fly	as	you	do	it	live,	so	thats	a	nice	little	workflow	too.	Bluebeam	Cloud	is	a	web-based	solution	so	its	usable	on	any	web	browser,	on	PC	or	Mac.	For	iPad	users,	we	also	have	Revu	for	iPad.	And	they	all	collaborate	with	Studio
Sessions.	What	Bluebeam	has	is	an	add-in	for	AutoCAD.	And	essentially	what	were	doing	is	converting	to	a	PDF.	So,	convert	the	DWG	file	to	the	PDF,	which	then	can	be	used	for	markup	and	collaboration.	Bluebeam	was	founded	in	2002,	and	in	2014	we	joined	the	Nemetschek	Group	of	brands,	which	develops	software	solutions	for	the	entire	AECO
lifecycle.	Bonus	Fact!	Did	you	know	that	Bluebeams	first	solution,	Pushbutton	PDF	was	originally	designed	by	engineers	from	NASA,	who	were	really	frustrated	with	the	PDF	solution	they	were	using	at	the	time?	Yes.	OCR	is	optical	character	recognition	and	thats	where	the	software	will	convert	text	that	isnt	a	vector	or	real	text	inside	the	PDF,	its	an
image	of	text	or	numbers,	into	actual	text	and	numbers	that	can	be	searched.	Which	is	a	really	powerful	workflow	for	anyone	doing	quantity	take-offs	or	searching	for	particular	information	inside	a	PDF.	Bluebeams	head	office	is	in	Pasadena,	California.	And	weve	got	teams	all	over	the	United	States,	Canada,	the	UK,	Sweden,	Denmark,	Germany	and
here	in	Australia.	There	is	a	30-day	free	trial	and	its	important	to	note	that	collaboration	is	part	of	the	DNA	of	Bluebeam.	Anyone	with	a	licence	can	invite	a	guest	collaborator	to	join	in	on	the	Studio	Sessions.	There	are	three	Bluebeam	subscription	plans,	and	you	can	mix	and	match	them	based	on	different	roles	in	your	business.	Theyre	all	billed	per
user,	and	theyre	billed	annually.	And	with	that	subscription	you	also	get	access	to	Bluebeam	University,	tech	support	and	unlimited	secure	storage.	Yes,	it	is	free	for	students.	It	is	also	free	for	educators	as	well.	They	can	obtain	a	licence	and	they	also	get	access	to	Bluebeam	University	for	their	further	education.	And	they	can	also	get	heavy	discounts
on	becoming	a	Bluebeam	Certified	Professional.	Bluebeam	is	the	industry	standard	for	PDF	markups,	digital	workflows,	and	effective	project	collaboration.	Mark	up	2D	or	3D	PDFs	with	flexible	tools	for	every	trade	Build	custom	workflows	to	speed	up	end-to-end	tasks	Invite	teammates	to	mark	up	or	measure	in	real	time	Bluebeam	construction
software	is	used	for	PDF	markups,	digital	workflows	and	AECO	project	collaboration.	It	gives	teams	intuitive,	highly	customizable	tools	for	simplifying	complex	end-to-end	tasks.	It	also	allows	teams	to	mark	up	and	measure	together	in	real	time.	Bluebeam	offers	three	subscription	plans	you	can	mix	and	match	for	users	with	different	needs.	Check	out
our	pricing	page	to	learn	more.	Your	Bluebeam	free	trial	will	give	you	access	to	our	Complete	subscription	plan	for	14	days.	Youll	need	to	buy	a	subscription	to	continue	using	Bluebeam	after	your	trial.	Your	trial	will	give	you	full	access	to	our	most	comprehensive	subscription	plan,	Complete,	which	includes	the	latest	version	of	Bluebeam	Revu,	Studio
in	Revu	and	Bluebeam	Cloud	for	web	and	mobile.	Complete	also	includes	access	to	Bluebeam	University	courses	so	you	can	learn	key	features	and	workflows	live	or	on	demand.	Check	out	our	pricing	page	to	learn	more.	Yes!	We	recommend	all	students	and	educatorsapply	to	joinour	Academic	Program.	Those	who	qualify	get	full	extended	access	to
Bluebeam	Revu	20	for	free	during	the	academic	year.	It	looks	like	youve	already	tried	Bluebeam	with	this	account.	View	Our	Plans	It	looks	like	youve	already	been	assigned	a	Bluebeam	license,	or	youve	signed	up	for	a	trial	using	this	email	in	a	different	server	region.	Centralize	documents	in	one	place	so	office	and	field	are	always	in	sync.	Keep	PDF
sets	organized	with	the	time-saving	automation	and	hyperlinking	tools.	Or	use	AI	to	overlay	and	compare	documents	faster.	Add	customizable	markups	such	as	text,	highlights,	clouds,	callouts,	stamps	and	more	Create	multiple	offset	copies	of	markups	and	measurements	for	quickly	scaling	up	counts,	creating	forms,	grids,	and	more	Collaborate	from
anywhere	to	accelerate	design	reviews	and	reduce	miscommunication.	Mark	up	and	measure	together	simultaneously	across	devices.	And	track	every	change	from	the	start	to	ensure	transparency.	Securely	access,	view	and	edit	the	latest	project	updates	on	desktop,	web	or	mobile	Automatically	track	all	edits	to	see	who	said	what,	and	export	project
data	into	your	preferred	reporting	tool	Take	quick,	accurate	measurements	and	discover	your	projects	true	scope	faster.	And	export	all	material	quantities	to	your	preferred	bidding	software	to	win	more	jobs.	Track	running	totals	as	you	draw	with	dynamic	measurement	tools,	then	display	measurements	directly	on	the	drawing	itself	Standardize
communication	across	teams	and	projects	with	custom	tool	sets,	and	export	takeoff	data	to	Excel	for	easy	estimations	Take	control	of	worksite	safety	with	smart,	reliable	tools	for	digitally	collaborating	on	logistics	plans.	Mark	up	the	latest	set	with	teammates,	and	document	every	single	change.	Build	more	precision	into	your	schedules	and	agendas
with	centralized	document	management	Share	the	up-to-date	documents	with	every	relevant	collaborator,	stakeholder	and	subcontractor	With	the	release	of	Revu21,	features	and	functionalities	for	PDF	management	and	collaboration	are	now	available	upon	purchasing	one	of	our	new	subscription	plans:	Basics,	Core,	or	Complete.	However,	there	may
be	instances	when	you	access	Revu	without	a	subscription	or	work	with	others	who	dont	have	a	subscription.	In	this	article,	well	go	over	the	features	available	in	Revuand	Studio	to	those	without	a	subscription.	To	see	a	comprehensive	list	of	Revu21	features	available	for	each	subscription	plan,	visit	this	article.	When	accessing	Revu21	outside	of	a
Studio	Session,	markup	tools	are	grayed	out	if	you	dont	have	a	Bluebeam	Plan.	However,	you	can	still	open,	view,	and	print	PDFs,	as	well	as	fill	out	forms,	in	Read-only	mode.	Please	see	the	table	below	for	additional	Revu	features	that	are	available	outside	of	a	Session	without	a	subscription:	Feature	Description	Feature	Location	Access	and	view
recent	PDFs	File	Access	>	Recent	Files	Open	and	view	existing	3D	PDFs	File	>	Open	(Ctrl+O)	Open	existing	files	in	a	Studio	Project	or	Session	Studio	Check	Out	/	Check	In	existing	Project	files	Studio	Projects	Apply	standard	hatch	patterns	Properties	panel	Tools	>	Toolbars	>	Properties	Toolbar	Tools	>	Toolbars	>	Appearance	>	Change	Subjects
and	Comments	in	the	Tool	Chest	Tool	Chest	>	>	Detail	Export	tool	sets	from	the	Tool	Chest	Tool	Chest	>	>	Export	Track	and	manage	markups	via	the	Markups	List	Markups	List	View,	manage,	and	sort	markups	and	comments	Markups	List	>	Filter	List	Create	and	save	custom	Markups	List	filters	Markups	List	>	Filter	List	>	Select	column	header	>
Custom	Launch	multiple	instances	of	Revu	Start	or	desktop	>	Revu	Drag	document	tabs	into	new	windows	across	multiple	monitors	Document	tab	>	Right-click	>	Detach	Even	without	a	Revu21	subscription,	you	can	still	participate	in	Studio	Sessions.	However,	youll	have	limited	access	to	classic	markup	tools	and	customizations.	In	Sessions,	non-
subscribers	can	copy	other	users	markups	and	access	the	following	tools:	Feature	Description	Feature	Location	Text	Box	Tools	>	Markup	>	Text	Box	Callout	Tools	>	Markup	>	Callout	Pen	Tools	>	Markup	>	Pen	Highlight	Tools	>	Markup	>	Highlight	Line	Tools	>	Markup	>	Line	Arrow	Tools	>	Markup	>	Arrow	Dimension	Tools	>	Markup	>
Dimension	Cloud	Tools	>	Markup	>	Cloud	Cloud+	Tools	>	Markup	>	Cloud+	Stamp	Tools	>	Stamp	Non-subscribers	can	use	all	colors	for	their	markups.	Appearance	properties	such	as	fonts,	font	size,	line	styles,	opacity,	and	shape	modification	are	disabled.	Do	you	have	additional	questions	about	accessing	Revuwithout	a	subscription	or	general
questions	about	our	new	subscription	plans?	Feel	free	to	contact	us.	How-To	Revu	21	Subscriptions	Markup	This	article	covers	the	available	functionalities	for	working	in	Revu	and	Studio	without	a	subscription.	Bluebeam	Revu	is	a	software	application	that	allows	users	to	markup,	organize,	takeoff,	and	collaborate	with	PDF	files.Whether	you	are
focused	mainly	on	using	the	PDF	markups	feature	or	you	are	a	power	user	that	wants	to	use	Revu	for	complex	automated	processes,	there	is	an	edition	of	Bluebeam	Revu	that	is	right	for	you.Which	Revu	is	Right	for	Me?It	comes	in	three	editions	(Standard,	CAD,	and	eXtreme)	and	runs	on	Windows.	There	is	also	Bluebeam	Revu	for	iPad.	Bluebeam
Revu	Standard	is	the	essential	solution	for	intuitive	2D	and	3D	PDF	markups,	editing,	and	collaboration	Bluebeam	Revu	CAD	is	the	solution	for	CAD	users	includes	smart	plugins	for	2D	and	3D	PDF	creation	along	with	Standard	features.	Bluebeam	Revu	eXtreme	is	the	robust	solution	built	for	power	users	who	want	to	automate	complex	processes	and
push	the	limits	of	document	collaboration	along	with	Standard	and	CAD	features.	Bluebeam	Revu	Comparison	&	DifferencesHere	are	the	comparisons	and	differences	between	the	three	Bluebeam	Revu	editions.	You	can	view	the	comparisons	between	Bluebeam	Revu	Standard,	CAD,	and	eXtreme	key	features	as	well	as	document	markup	capabilities,
and	page	content	and	editing	features.What	is	Bluebeam	Studio?Bluebeam	Studio	is	the	free	cloud-based	version	included	with	every	copy	of	Bluebeam	Revu.	Built	into	Bluebeam	Revu,Studioenables	powerful	document	management	and	real-time	collaboration.Studio	Projectsgive	you	a	single	centralized	location	to	store	documentseven	entire
building	projectsin	the	cloud.	And	Studio	Sessions	let	project	teams	review,	mark	up	and	update	the	same	files	at	the	same	time.Keep	track	of	who	said	what.Mark	up	at	the	same	time	together	usingStudio	Sessionsand	automatically	track	all	comments,now	with	a	visual	cue	to	help	you	find	the	latest	conversationsSpeed	up	design	reviewsLive	activity
feed	helps	improve	communication	across	teamsCustomize	collaboration	permissionsNewly	enhanced	process	for	setting	permissions	ensures	the	right	people	have	access	to	the	right	information	from	the	startWhat	are	the	benefits	of	using	Bluebeam	Revu?Bluebeam	Revu	helps	companies	stay	on	track	throughout	their	entire	projects;	it	keeps	the
design,	engineering,	and	construction	team	on	the	same	page	throughout	the	entire	design	process.Instant	teamwork,	better	buildingBluebeam	Revu	gives	you	the	smart	tools	you	need	to	keep	your	team	in	sync	and	get	the	job	done	rightanytime,	anywhere.Get	more	done,	togetherConnected	teams	are	efficient	teams.	Studio	in	Bluebeam	Revu	allows
you	to	easily	invite	team	members	from	anywhere	in	the	world	to	collaborate	in	real-time	and	finish	projects	faster.Finish	projects	on	time,	every	timeRevu	gives	you	a	centralized	place	to	create,	annotate	and	share	documents,	so	projects	always	stay	on	track	and	teams	are	aligned	every	step	of	the	way.Simplify	all	tasks	from	start	to	finishStop
juggling	platforms!	Revu	offers	a	wealth	of	powerful	tools	and	plug-ins	to	help	simplify	tasks	from	kickoff	to	handoff.	Interested	in	a	Trial?Click	hereto	get	your	free	30-day	Bluebeam	Revu	trial.	Interested	in	buying	Bluebeam	Revu?Clickhereto	get	buy	your	Bluebeam	Revu	online.	If	you	have	questions	or	need	additional	information,	you	can	request	to
meet	with	our	Bluebeam	Specialists.	Lets	Talk	INDUSTRIES:	Architecture,	Buildings,	Civil	Engineering,	Civil	Infrastructure,	Construction,	MEP	Engineering,	Structural	Engineering	

Is	bluebeam	free	for	students.	Bluebeam	free	download.	How	to	get	bluebeam	for	free.	Is	bluebeam	free.	Bluebeam	license	upgrade.	Is	there	a	free	version	of	bluebeam.


